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The information in this document reflects products at the date of printing. 
Unitronics reserves the right, subject to all applicable laws, at any time, at its 
sole discretion, and without notice, to discontinue or change the features, 
designs, materials and other specifications of its products, and to either 
permanently or temporarily withdraw any of the forgoing from the market. 

All information in this document is provided "as is" without warranty of any 
kind, either expressed or implied, including but not limited to any implied 
warranties of merchantability, fitness for a particular purpose, or non-
infringement. Unitronics assumes no responsibility for errors or omissions in 
the information presented in this document. In no event shall Unitronics be 
liable for any special, incidental, indirect or consequential damages of any 
kind, or any damages whatsoever arising out of or in connection with the use 
or performance of this information. 

The tradenames, trademarks, logos and service marks presented in this 
document, including their design, are the property of Unitronics (1989) (R"G) 
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HMI Display Editor
Use the HMI Display Editor to create the Displays that the controller shows on 
its screen after the program is downloaded.  When you click on HMI in the 
Project Explorer tree, a Display replica opens. The replica reflects the type of 
Vision controller you have selected in your project's Hardware Configuration.  

Displays tell your operators what to do.  You can have your operators log in 
with a password, enter setpoints and other data, and instruct the operator 
what to do in case of a system problem or alarm. A Display can contain both 
text and images.  Text and images can be both fixed and/or variable.  If the 
project is based on a touch-screen controller, you can also assign touch 
properties to on-screen objects. 

Variables  are inserted into a Display to: 

 Show run-time values as integers 

 Represent run-time values with either text, images, or bar graphs 

 Show text messages that vary according to runtime conditions.   

The features in the HMI editor are determined by the controller type selected 
in Hardware Configuration. The next image is from a project based on a 
Enhanced Vision controller comprising a color touch screen. 
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Color and Enhanced Vision 
When, in Hardware Configuration, you select an Enhanced or Color Vision, the 
HMI editor changes accordingly and shows additional options such as Frame and 
Button.  
 

Getting Started with Displays
Text in HMI Displays 

Displays can contain both fixed and Variable text.  Fixed  (constant) text does 
not change according to run-time conditions.  Variable  text can show run-time 
values, such as timer values, or  display operating instructions acco rding to 
system status. 

Graphic Images in Displays 
Simple geometric shapes can be drawn on a Display.   
Graphic images can be imported from the Image Library, or created with a 
program such as Microsoft Paint and then imported. 

 Fixed graphic images 
This type of image stays on the screen and does not change until a 
different Display is loaded by the program. 
 

Variable graphic images 
Variable images change according to the value of a linked operand. 
 Binary Image Variables are linked to bit operand status ( MB, SB, I, T, 
O).  List Image Variables are linked to integers ( MI, SI, ML, SL )

Copy & Paste Displays 
You can copy and paste Display elements. 

1.  Copy the Display element(s) or select all of the elements in a Display. 
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2.  Paste the elements into the Display. 

 
-or- 
Select Paste from the Edit menu. 

Note • When you paste elements into a Display, the elements paste 
into the same relative area in the new net. The elements 
'remember' their original location.  Therefore, before you paste 
elements into a Display that already contains elements, move 
any elements that occupy the same position as the paste 
selection. 

 If you paste variables that are linked to named constant values, 
note that the constant's description is lost during the paste 
operation. 

 Variables do not retain their descriptions; they are renamed as 
Variable 1, Variable 2, etc.. 

 To copy elements between projects, copy your selection from 
the source project, then open a target project without  closing 
VisiLogic, either by using the New Project or Open project 
buttons or via these options on the Project menu. 
If you close VisiLogic, the selection will be lost. 

Import/Export Displays 
You can export displays and save them as .vld files, then import them into 
other projects. 

Export 

1.  Select Export Displays from the Project menu. 

2.  Select the display you want to export, and click Add. 

3.  When you have added all of the displays you want, save them as a .vld 
file to the desired location. 

Note • Displays that contain Trend variables cannot be exported
If a Display contains variables that are linked to the String 
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Library, these strings will not be exported with the variables

Import 

1.  Select Import Displays from the Project menu. 

2.  Select the displays you want to import, and click OK; VisiLogic imports t he 
displays.. 

3.  When you have added all of the displays you want, save them as a .vld 
file to the desired location. 

Note • If you do not want to overwrite displays already in the project, 
you must use unique names. You can click the Target Display 
Names and enter a new name. 

Undo 
VisiLogic supports up to 10 Undo/Redo actions. 

 

The list of supported actions is shown below. 

Ladder HMI Project 
Delete ladder element Delete HMI Display Compile 
Delete ladder net Delete HMI Elements Build All 
Delete Comments Clear HMI Display   
Cut Ladder Elements Cut HMI Element   
Cut Ladder Net Paste HMI Elements   
Paste Ladder Element     
Paste Ladder Net     
Clear Sub     
Import Sub     

Changing Displays (Jumps) 
To change between Displays, set Jumps . A Jump  contains a Jump condition, 
which is linked to a bit operand, and a destination Display.  You can also 
change Displays by placing a Load Display function in a Ladder net. 

Setting Jumps 

1.  Open a Display. 
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2.  Click on a Jump Condition field, and select an operand. 

 

3.  Click on Display field, and select a destination Display. 

 

To edit a Jump, click the desired field and make a new selection. 

Notes • When an HMI keypad entry variable is active, and the Enter key is 
pressed on the controller keypad, SB 30 HMI Keypad Entries Completed 
turns ON. This can be used as a Jump condition. 

• To see a list of Displays in a project together with their Display 
numbers, select HMI Information from the View menu. 
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Getting Started with Variables
Variables 

Variables  enable you to show run-time values, text, images, and bar graphs 
on the controller's screen in response to run-time conditions. Bit, or bi nary text 
variables, for example, display text messages on the controller's LCD scre en 
according to the status of a bit operand. 

The maximum number of variables per display  depends on the Vision 
controller division. 

 Standard Vision: supports up to 24 variables 

 Enhanced Vision: supports up to 255 variable 

You can also use Keypad Entry Variables to enable an operator to enter a 
password, or data such as setpoints from the controller's keyboard. 

Variable Editor 

When you insert a variable into a display, the Variable Editor opens, s howing 
you the options that are relevant for that Variable. 

Note that for some types of variables, the type of controller selected in 
Hardware Configuration may determine some of the variable's properties. For 
example, touch-screen models enable you to assign Touch Properties to on-
screen objects. 

The next image shows a binary variable used in a V120 project. 
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The next image shows numeric variable options for touch-screen color models. 
These enable you to assign Touch Properties to on-screen objects, and off er 
options for depth and color. 

 
Hide • Causes the object/text to disappear from view 

• Suspends any touch properties 
Disable • 'Greys' a button object 

• Suspends any touch properties 
Marking View • Changes the color of the button to dark blue background, white invers e text 

• Does not affect touch properties 
Keypad OK • Turns ON when Keypad Entry value is within legal limits 

• Turns OFF when Keypad Entry value exceeds legal limits 

After you have inserted Variables into a display, they are shown with that 
display in the Project tree. 
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Inserting a Variable into a Display 
To show variable data: 

1.  Click on a variable in the HMI toolbar, then click on the HMI screen an d 
drag your cursor to create a field for the display of the variable data.  
 

2.  Release the mouse button; a dialog box opens, enabling you to define the 
source of the variable data. 
The next image shows a binary variable, named Switch Status, linked to 
MB0.  
When MB 0  
 = 0, the text OFF will be displayed in the field. 
 =1, the text ON will be displayed in the field. 

 

Field: Too Small

If a field is too small to display data, a warning message is displayed at 
compilation and download. In addition, monochrome controllers color a fie ld 
that is too small in red. 
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HMI Displays

About the HMI Display and Keypad
All Vision controllers offer an integrated HMI operating panel that includes  an 
LCD screen and a keypad. The screen size, type and keypad vary. Exact 
specifications regarding Vision operating panels are included in the user's 
manuals. 

'Touchscreen' controllers 
There are different types of Vision touch-screen models: 

 

Monochrome LCD +
HMI function keypad and  virtual keypad 
Maximum number of displays: 255 
Maximum number of variables per display: 24 

In these models, activate the virtual keypad by turning SB 22 Enable Virtual 
Keypad ON. This must be done at power-up, or before entering a Display 
containing a keypad variable. In addition, the Keypad entry variable must b e 
assigned a Touch Property. 

 

Monochrome LCD +
Virtual keypad only  
Maximum number of displays: 255 
Maximum number of variables per display: 24 

In these models, the virtual keypad opens whenever the user touches a 
keypad entry variable that is currently displayed on the screen. 
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Note that to enter Information Mode, you touch the touchscreen in an area 
that is not occupied by a Keypad Entry variable or other screen object that has 
been assigned a Touch Property. 

 

Color Touchscreen LCD+
virtual keypad only  
Maximum number of displays: 1024 
Maximum number of variables per display: 255 

The virtual keypad functions in the same way as in monochrome models. 

 

Inserting a Variable into a Display 
To show variable data: 

1.  Click on a variable in the HMI toolbar, then click on the HMI screen an d 
drag your cursor to create a field for the display of the variable data.  
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2.  Release the mouse button; a dialog box opens, enabling you to define the 
source of the variable data. 
The next image shows a binary variable, named Switch Status, linked to 
MB0.  
When MB 0  
 = 0, the text OFF will be displayed in the field. 
 =1, the text ON will be displayed in the field. 

 

Field: Too Small

If a field is too small to display data, a warning message is displayed at 
compilation and download. In addition, monochrome controllers color a fie ld 
that is too small in red. 

 

Align, Space & Center Display Elements 
When you align, space, and center elements, be careful not to make them t he 
same size and align them one on top of the other. If elements are 'fused' 
together in this way, they cannot be separated. 



About the HMI Display and Keypad Global HMI Variable Bank

VisiLogic: HMI Applications 15

Note • The HMI d isplay uses a grid which spaces the lines 8 pixels apart. To 
optimize Displays and shorten the PLC cycle time, images and variables 
should be aligned to grid. 

Global HMI Variable Bank 
The Global HMI Variable bank can contain any type of HMI variable. When you 
open a VisiLogic project, the bank is empty. You enter variables in the bank  by 
first creating a variable, such as a List of Images variable, and then addin g it 
to the bank. Once a variable is in the bank, you can refer to it from any HMI 
Display; although you can change the linked operand, the rest of the 
parameters remain the same. 

Why use Global Variables? 

Variables take up space in the controller's Flash memory.  In some 
applications, you may copy and paste a variable to a number of Displays, 
changing operand links where required.  In these applications, you can save a 
great deal of space--and download time--by using a Global Variable, and 
referring to it as required. No matter how many times you refer to a Global 
Variable, it is a single variable. 

Creating and Using Global Variables 

1.  Either create a new variable and then right-click on it, 
or 
right-click on an existing variable, then select Set As Global Variable. 
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2.  Enter a name for the Global Variable, then click OK. 

 
3.  The variable is now part of the Global Variable bank; in the Display, the 

variable now appears with an arrow, indicating that it is actually a 
reference to a Global Variable. 

 

Referring to a Global Variable

Once the variable is in the bank, you can refer to it from any HMI Display . 

 To insert a Global Variable 

1.  Click on Insert Global Variable, then click on the display and drag 
the cursor; the Get Global Variable box opens. 

2.  Select a variable, then click Link to open the Select Operand and 
Address box and link an operand to the variable; the operand 
address appears in the Link field 

 
3.  Click OK, then the variable now appears with an arrow, indicating 

that it is actually a reference to a Global Variable. 

 To link an existing variable to a global variable. 

1.  Right-click the variable and select Get Global Variable; the Get 
Global Variable box opens. 
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2.  Select a variable, then click Link to open the Select Operand and 
Address box and link an operand to the variable; the operand 
address appears in the Link field 

 
3.  Click OK, then the variable now appears with an arrow, indicating 

that it is actually a reference to a Global Variable. 

 

Note • A Global variable cannot be resized.
• Deleting the last link to a Global Variable also deletes the Global 

Variable .

Changing Displays (Jumps) 
To change between Displays, set Jumps . A Jump  contains a Jump condition, 
which is linked to a bit operand, and a destination Display.  You can also load  a 
Display by placing a function in a Ladder net. 

Setting Jumps 

1.  Open a Display. 

2.  Click on the Links & Jumps  tab. 
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3.  Click a Jump Condition field, and select an operand. 

 

4.  Click on Display field, and select a destination Display. 

 

To edit a Jump, click the desired field and make a new selection. 

Notes • When an HMI keypad entry variable is active, and the Enter key is 
pressed on the controller keypad, SB 30 HMI Keypad Entries Completed 
turns ON. This can be used as a Jump condition. 

• To see a list of Displays in a project together with their Display 
numbers, select HMI Information from the View menu. 

Calling a Subroutine via Display 
You can use a specific Display to call a specific Subroutine.  This Sub routine 
will run during the time that the Display is shown on the controller's LCD. 

Standard Vision Controllers 
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Standard Controllers Only  

SBs 33 and 34 function when an HMI Display that calls a subroutine is 
loaded/unloaded from the display screen. 

 SB 33: Load Display with linked Call Subroutine 
When a Display containing a Call Subroutine starts loading , SB 33 turns 
ON for a single scan cycle the first time the linked subroutine runs. Use 
this SB to initialize operands in the HMI subroutine. 

 SB 34 UnLoad Display with linked Call Subroutine) 
When a Display containing a Call Subroutine starts unloading , SB 34 
turns ON for a single scan cycle the last time the linked subroutine runs. 
If a Display contains an ASCII String Variable, and the linked subroutine 
contains the Display String 'trigger' MB, reset this MB when the Display 
unloads by using the falling edge of SB 34. 

 



About the HMI Display and Keypad Calling a Subroutine via Display

20 VisiLogic: HMI Applications

Enhanced Vision 

These controllers enable you to call three subroutines: 

 One to run for a single scan when entering the Display (On Load Display) 

 One to run the entire time the Display is on-screen (While Displaying)  

 One to run for a single scan when exiting the Display (On Un-load Display) 

In addition, you can link an MB which will be ON while the Display is shown on  
screen, or an XB which will change status. 

 

To clear the subroutines and bits, right-click the relevant field. 
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HMI Information 
To see a list of Displays in a project together with their Display numbers, s elect 
HMI Information from the View menu. To see keypad entry variable ID 
numbers, click the variable tab. 

 

Elements Draw Order 
This feature is available in Enhanced Vision controllers. 

Except for variables, which cannot be placed one on top of another, the 
elements in a display are shown in layers according to the order in which they 
were drawn. The last element is on top of the others. 

You can change this order by using the arrows in Draw Order. 

In the next image, Rectangle 1 is on top of Rectangle 2. 



About the HMI Display and Keypad HMI-Ladder: Load HMI Display: Fu nctions

22 VisiLogic: HMI Applications

In the next image, Rectangle 2 is on top of Rectangle 1. 

 

HMI-Ladder: Load HMI Display: Functions 
These Ladder functions call HMI Displays. Use these functions to in itially load 
the Display, and then to refresh it when your application requires, as, for 
example, when you want to update variable display. They are located on the 
Ladder toolbar, under the HMI menu. 

Note • Load Display functions should not be placed directly on the 
Ladder rail, or called by conditions that continually call the 
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Display when it is still loaded on the controller screen. 

• You must use a transitional contact to activate a Load HMI 
Display or Load Last Display function. 

Load HMI Display 

Causes a Display to be shown on the controller's LCD as a response to a 
Ladder Condition. 

 
Accessing a Load Display Target  

HMI Display Loaded 

This turns a linked MB ON when a specific Display begins loading. 
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Load Last Display 

Loads the last Display loaded by the application. The function works accordi ng 
to LIFO list comprising the last 24 active Displays. 

 
To see a list of HMI Displays in a project, together with the Display n umber, 
select HMI Information from the View menu. 

 

Resizing HMI Elements 
Resize an element by selecting it, then: 

 Dragging the image handles. 

 
Clicking the Fit to Original Size (content) button. 

 
Clicking the Element Sizer, then selecting the desired size. 
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Selecting more than one element, then make them of uniform size via the 
Resize buttons. 

 
HMI Element Resizing/Rotating Limitations  

Elements 'grow' down, and to the right. If resizing/rotating will cause Variable  
elements to collide, or any element to extend beyond the boundaries of the 
Display, the element cannot be returned to its original size, or resized to a 
larger size. 

 
Note • Fit to Original size functions differently for .bmp and for .wmf.

.bmp: Resizes the image to the actual size of the element as it 
appears in the element's ToolTip; assuming that this size does 
not exceed the size of the display screen. If the original image 
exceeds the display size, the function will  fail. 
 
.wmf/.emf: the image will be resized according to the size at 

which it was first inserted into  the HMI application. 
• 'Original size' cannot be use d to resize Variable elements if the 

elements have differing original sizes. 
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.
Note • Although an imported image can be resized, resizing may result in 

some degree of distortion. 
To avoid this, use images that are created to match the required size. 

• Resizing text elements changes the size of the text field, but does not 
affect font size. 

• Fit to Original Size does not affect geometric shapes that are drawn on 
the Display. 

• Shapes that are imported are resized in proportion to their original s ize.

HMI SB and SIs 
Keypad keys 

SB 40 Key: # 0   
SB 41 Key: # 1 
SB 42 Key: # 2   
SB 43 Key: # 3   
SB 44 Key: # 4 
SB 45 Key: # 5 
SB 46 Key: # 6 
SB 47 Key: # 7 
SB 48 Key: # 8 
SB 49 Key: # 9   
SB 50 Plus/Minus 
SB 51 Left Arrow 
SB 52 Right Arrow 
SB 53 ENTER 
SB 54 Key <i> (ON when in Info mode, may also be turned ON in order to enter  

Info mode, via Remote Access or user program) 
SB 55 Up 
SB 56 Down 
SB 57 ESC 
SB 58 F1   
SB 59 F2 
SB 60 F3 
SB 61 F4 
SB 62 F5   
SB 63 F6 
SB 64 F7 
SB 65 F8 
SB 66 F9 
SB 67 F10 
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SB 68 F11 
SB 69 F12 
SB 70 F13 
SB 71 F14 
SB 72 F15 

# Description Turned ON Turned Off Comments 
SB 6 Keyboard is active 

 
By OS By OS   

SB 16 Touchscreen 
Active, V280 only 

When LCD is 
touched 

When LCD is 
not touched 

The touch property must be 
assigned to a variable. If this 
property is assigned, touching 
the variable activates it, causing 
it to be marked by the blinking 
cursor. 

SB 17 Enable/Disable 
Touch-screen 
indication 
(Message Board 
function)  
V280/290 only 

By program By program Enables a message to be 
handwritten on the touch-
screen with a stylus   

SB 22 Enable Virtual 
Keypad 
Enable Virtual 
Keyboard 
(Relevant only to 
Standard Vision + 
Touchscreen, not 
Enhanced) 
 

• ON by 
default in 
Touchscreen
-only models

• By program, 
to enable 
V280 Virtual 
keypad 

Off by default 
in all other 
models 

Causes a Virtual Touchscreen to 
be shown on screen when the 
user touches a display entry 
variable. 
• In Touchscreen + HMI 

keypad models (V280), 
user turns ON to enable 
Virtual Keypad. When ON, 
the normal alphanumeric 
keypad does not  work .

• May be turned OFF by user.
SB 26 Exiting OS Draw 

Mode (ON for 1 
cycle after OS 
draw) 

By OS 
Turns ON for a 
single cycl e when 
SB 28 turns OFF. 
This happens at 
the following 
times: 
• When the 

PLC exits 
Info Mode 

• Rises the 
cycle after a 
Display is 
entered. 

• When Virtual 
Keypad 
mode exits. 

By OS OS Draw Mode means that the 
controller's Operating System 
takes control of the LCD screen:
• During Info Mode 
• When a Display is entered 
• When the Virtual Keypad 

(touch-screen models) is 
displayed 

SB 27 Disable all keypad 
automation 
(touch-screen + 
keyboard models 
only, V280)  

By program 
• If SB 22 is 

ON, SB 27 
turns ON 
automaticall
y

By program If SB 27 is ON when a Display is 
shown: 
� The user cannot navigate 

through the variables using 
the Enter or Right-arrow 
keys. 

� No Keypad Entry Variable 
will be marked by the 
blinking cursor. In this 
case, a variable may be 
activated by: 
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� Touch (V280 only)--
assuming it has been 
assigned the Touch 
property. 

� By writing the variable 
ID # into SI 250, either 
via Info or Online mode.

SB 28 LCD: controlled by 
OS  (OS drawing 
on LCD) 

By OS at entry to 
drawing mode, 
remains ON 
during the 
drawing task: 
� Info Mode. 
� Rises when a 

Display is 
entered. 

� When the 
V290 enters 
Virtual 
Keypad 
mode and 
displays the 
virtual 
keypad on 
the LCD 

By OS 
when the OS 
exits the 
drawing mode:
� PLC exits 

Info 
Mode. 

� After a 
Display is 
entered. 

� When 
 Virtual 
Keypad 
mode 
exits. 

Any Ladder- drawn elements 
(ex. Draw Axis, Trends, Draw 
Pixel/Line), are cleared when SB 
28 turns ON; the programmer 
may use the Negative Transition 
of SB 28 to refresh these 
elements on the LCD. 
 

SB 29 HMI keypad 
entries complete, 
reload vars 
 
(Relevant for non 
touch-screen 
models: V120, 
V230,V260)  

By program By OS Turn SB 29 ON after data is 
keyed into any variable, to 
enable the user to skip  keying 
in data for the remaining  
variables in the current display. 

When SB 29 is ON: 
• No cursor blinks on screen. 
• The current values of all 

variables is loaded on 
screen. 

SB 30 Current keypad 
entry sets SB 30 
(HMI keypad 
entries complete) 
(Relevant for non 
touch-screen 
models: V120, 
V230,V260)  

• By OS 
• By SB29 

turning ON 
• By program 

• When a 
Display is 
entered 

• By turning 
SB31 ON 

• When SB 
27 and 29 
turn OFF 

• When 
keypad 
entry 
variable is 
touched 

Use SB 30 to run ladder tasks 
that require data entered via 
keypad. 
• When a variable is active, 

pressing the Enter button 
on the keypad signals that 
the user has finished 
entering the value. When 
the Enter button has been 
pressed for each variable in 
the current display, SB 30 
turns ON. 

Note  • To immediately re- enable 
data entry (restore cursor) turn 
SB31 ON 

SB 31 Refresh current 
LCD screen display 
variables 
(Relevant for non 
touch-screen 
models: V120, 
V230,V260)  

By program By OS Restores the Display cursor, re-
activates all keypad entry 
variables in the current Display.

SB 32 HMI keypad entry 
in progress 

By OS By OS This turns ON automatically 
when the blinking cursor is on 
an active variable. 

SBs 33 and 34 function when an HMI Display that calls a subroutine  is loaded/unloaded from the 
display screen. 
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Note • ASCII String Display: In cases where a Displ ay contains a Display ASCII String Variable , and the 
linked subroutine contains the Display String 'trigger' MB, reset this MB w hen the Display unloads by 
using the falling edge of SB 34. 
SB 33 Load Display with 

linked Call 
Subroutine 

By OS By OS When a Display containing a 
Call Subroutine starts loading ,
SB 33 turns ON for a single scan 
cycle the first time the linked 
subroutine runs.. 
Use this SB to initialize 
operands in the HMI subroutine.

SB 34 UnLoad Display 
with linked Call 
Subroutine 

By OS By OS When a Display containing a 
Call Subroutine starts 
unloading , SB 34 turns ON for 
a single scan cycle the last time 
the linked subroutine runs. 

SB 36 INFO mode By OS, Remote 
Access, or 
program 

Turns OFF 
when user 
exits Info 
Mode 

 

SB 37 Exclude last 
Display from FIFO 

By Remote 
Access, or 
program 

OS Enables user to skip going back 
to certain Displays. 

SB 38 Invert Touchscreen 
element pixels 
(Text, images) 

By program By program If a Touchscreen text or image 
element is touched and this bit 
is on, the pixels in the element 
reverse color. 

SB 76 Keypad Entry: 
Focus (V130) 
 (Press "Enter" 1x)

By program By program If SB 76 is OFF after Keypad 
Entry, the user must use the 
arrow keys to move to the next 
variable. Turning SB 76 on 
causes the next variable set in 
Variable Tab Order to 
automatically become active. 
(can be used with SB108 

SB 
108 

Press "Enter" 1x 
(V130) 
 

By program By program Normally, when a user enters a 
Keypad Entry value on a V130 
HMI, the user must press the 
Enter button twice: 
 - Once to 'approve' the value 
 - Once to jump to and activate 
the next variable. 
You can control this by turning 
both SB 76 and SB 108 ON in 
your application. Note that the 
user can press ESC to exit 
keypad entry mode. 

SB 
110 

Draw: Out of 
Range 

The OS attempts 
to draw a line or 
pixel outside of 
the legal limits of 
the controller's 
LCD. 

At the 
beginning of 
every cycle 

OS 

SB 
250 

Keypad entry 
within limits 
(Standard Vision. 
Enhanced Vision 
variables use 
status operand) 

By OS By OS 
-The current 
Display is 
either re-
called or 
changed, 
or 
-At the 
beginning of 
the next 
program cycle.

Turns ON for one scan when the 
entered value is within the 
Min/Max limits set in the 
variable's parameters. 
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SB 
251 

Keypad entry 
exceeds limits 
(Standard Vision. 
Enhanced Vision 
variables use 
status operand) 

By OS By OS 
- The current 
Display is 
either re-
called or 
changed, 
or 
- At the 
beginning of 
the next 
program cycle.

Is ON when the entered value is 
within the Min/Max limits. 
 Note  • When this SB is ON, the 
blinking cursor remains on the 
active variable even after the 
user presses Enter. 

SI 6 Current key pressed 
SI 7 LCD Contrast Control: 0=Minimal Contrast, 50=Medium Contrast, 100 =Maximal 

Contrast 
SI 9 LCD Backlight intensity 
SI 40 Touchscreen is being touched- X coordinates 

If the screen is touched, SI 40 shows the current location on the X axis. 
SI 41 Touchscreen is being touched-Y coordinates 

If the screen is touched, SI 41 shows the current location on the Y axis. 
SI 50 INFO delay time - Default by O/S (every power up) = 4 seconds. 

• Units: seconds. 
• Legal values: 0, 3 to 20. 
• If you force or store '0' into equal Zero INFO is disabled. 
• For V290 Touching the <i\> key on the touch screen starts Info Mode T ouching 

a legal Ladder application variable clears the INFO time. 
SI 249 Last Active Keypad Entry Variable 

Contains the ID number of the last active variable. 
SI 250 Currently active keypad entry, read/write. 

When either SB 250' Keypad Entry Within Limits' or  SB251 'Keypad Entry Exceeds 
Limits' turn ON,  the index number of the variable is stored here. As yo u navigate 
between variables, as for example with the right-left arrow keys, SI  250 will show only 
the numbers of variables that have not been completed. 
Note  • A value of -1 indicates that, in this particular display, the user has pressed Ent er 
for all the Keypad Entry variables in the Display. 

SI 251 Previous HMI Display Number 
SI 252 Current HMI Display Number. 

To see a list of Displays in a project together with their Display numbers , select HMI 
Information from the View menu. 

# Description Value Comments 
SDW 
10 

Keypad entry 
variable value 

 When a keypad entry 
variable value is entered, 
this SDW 10 holds the 
value. 

SDW 
30 

Variable display 
bitmap, 0=Normal, 
1=Inverse (or 
negative) 

The value is checked when a display 
is entered. 
It is initialized to 0: 
 - At Power-up. 
 - When the program exits the 
Display. 

When a bit is ON, the 
corresponding variable is 
displayed in inverted 
(negative) color; black 
pixels are changed to white 
and white to black. 

SDW 
31 

Hide Var The value is checked when a display 
is entered. 
It is initialized to 0 at: 
 - Power-up. 
 - When the program exits the 
Display. 

When a bit is ON, the 
corresponding variable is 
hidden 



About the HMI Display and Keypad Images

VisiLogic: HMI Applications 31

Images 
Graphic Images in Displays 

Simple geometric shapes can be drawn on a Display.   
Graphic images can be imported from the Image Library, or created with a 
program such as Microsoft Paint and then imported. 

 Fixed graphic images 
This type of image stays on the screen and does not change until a 
different Display is loaded by the program. 
 

Variable graphic images 
Variable images change according to the value of a linked operand. 
 Binary Image Variables are linked to bit operand status ( MB, SB, I, T, 
O).  List Image Variables are linked to integers ( MI, SI, ML, SL )

You can draw graphic images directly on a Display, or import images. 

Notes • Although an imported image can be resized, resizing may result in 
some degree of distortion. To avoid this, use images that are created to 
match the required size. 

• The HMI display uses a grid which spaces the lines 8 pixels apart. To 
optimize Displays and shorten the PLC cycle time, images and variables 
should be aligned to grid. 

Color Images  

Color Vision supports .wmf, .emf, .bmp, .png, and .jpg. 

However, to get the best results, follow these recommendations: 

 Create images using a vector-based graphic design program. 

 Set your PC Display color depth to 32-bit: right-click the desktop, sele ct 
Properties>Settings, and under Color Quality select 32-bit. 

 Create images of the correct size, so that they will not have to be resized 
within VisiLogic. 
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Use .wmf or .emf image formats. If these must be resized, they will give 
better results than .bmp, .jpg, or .png 

Why images may distort when imported into VisiLogic and displayed on the 
controller's screen:

Resized images: jpg, png, and bmp are 'lossy', which means that quality is lost 
when the image is resized. If images must be resized, emf and wmf will gi ve 
better results. 

Color conversion: VisiLogic uses the basic pallet shown below. When an image 
contains additional colors, an algorithm performs color substitutions 
(interpolation. This means that the results may not reproduce the colors in the 
original image. 

Selecting Quantization  

Note that you can select between two algorithms, RGB and LAB. LAB generally 
gives better results, however note that the image conversion process may take 
longer. 

1.  From the HMI menu, click Quantization, and then select RGB or LAB. 

 
To see the color pallet, select an object Properties from the HMI menus, an d 
then click on one of the colors. 
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Images: Fixed 

This type of image stays on the screen until a different Display is loaded by  the 
program. 

 

Once the image is on the display, you can open its properties by double -
clicking it. Note that via Properties, you can resize the image and open it in 
Microsoft Paint for editing. 

 

Variable Images 

Variable images change according to the value of a linked integer. 



About the HMI Display and Keypad Images

VisiLogic: HMI Applications 35

Image Library 

A library containing hundreds of images can be found in the Unitronics folder 
on your hard drive ( Unitronics\VisiLogic\Data\Images). 

This makes it easy to locate and import images into your displays. 

Note • An imported image cannot exceed the size of the c ontroller's display 
screen listed in the model's technical specifications. For example, th e 
V230's Display screen is 128x64 pixels, therefore an image of 100x 100 
pixels cannot be used unless it is resized in a third-party utility such as 
Paint. 

• Clicking any HMI image in a Display will open the Image Library; to 
open the image for editing In Paint, click the Paint icon on the lower lef t 
side of the Library frame. 

For tips on how to edit images to best suit the controller's Display screen, first 
read the Help Topic Creating Images with Microsoft Paint, and then view the 
demo located on the VisiLogic setup CD:  Edit Image Collections with Paint 
Step 1.exe .
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Drawing Shapes on a Display 

VisiLogic's Shape toolbar enables you to draw lines, rectangles, rounded 
rectangles, and ellipses. Color Vision series also include Frame and Button. 

The Display Grid can aid in sizing and aligning images directly on a Displ ay. 

 

You can edit an object's properties. 



About the HMI Display and Keypad Images

VisiLogic: HMI Applications 37

You can also resize a shape by clicking it, then dragging the image handles . 

 

Draw Static Axis 

This HMI utility enables you to place background axes for graphs. 

1.  Click on Create Static Axis, then click on the Display. 

2.  Create Static Axis opens, drawing the axis and showing the default 
settings. 

3.  Edit the default settings, if desired, then click OK. 

The default settings may be edited; you can also select whether to place a 
frame around the Draw area. 
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Lock Display 

Locking a Display prevents you from moving display elements accidentall y. 
When the Display is locked, you can continue adding new elements. In a 
Locked display, the elements are marked with red; unlocked displays are 
marked by green. 

 

System Images 

You can customize your application by replacing system images, suc h as the 
Unitronics' Splash Screen, and the Unitronics' icon that appears in Inform ation 
mode, with you own custom images. 

1.  On the Project menu, click System images. 

2.  Click on the desired image, click on Replace Image, and navigate to your 
custom image.. 

 
Notes • You can restore default System Images by clicking on the appropriate 
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button
• You can replace the virtual keypad images; however note that the 

touch locations for the keys will not be changed from the default. 

Display Variable Types 
Variable Types 

Note that some of the variables listed below and shown in the next picture are 
dependent on controller type. 

Text 
Variable 

Image 
Variable 

Numeric 
Variable 

Clock 
Variable 

Timer /Counter
Variable 

SD 

Binary (bit) 
 Text 

Binary 
Image  

Number  Real Time 
Clock 

Timer SD 
Browser 

List of Texts: 
by Pointer  

List of 
Images: by 
Pointer  

Password  Clock 
Variables 

Counter  

List of Texts: 
by Range  

List of 
Images: by 
Range  

Bar/Shape 
Graph 
Trend 
Graph 

Clock 
Variable: 
View\Enter 
RTC\UTC 
Value  

ASCII String  

Display RTC 
(ASCII)  
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Bit (Binary) Text Variable 

This type of variable displays a different text message on the controll er's LCD 
screen according to the status of a bit operand. 

 

Inserting and Defining the Variable 

1.  Click on the variable in the Variable toolbar, then click on the HMI screen 
and drag your cursor to create a field for the display of the variable data.  

2.  Release the mouse button; a dialog box opens, enabling you to define the 
source of the variable data. 

3.  Link a bit operand, and enter text for both bit states. 

 



About the HMI Display and Keypad Display Variable Types

VisiLogic: HMI Applications 41

Color Vision series also offer a Switch property. Selecting Switch assign s an MB 
and built in Touch property to a binary variable. Touching the variable toggles 
the image or text displayed. 

 

Bit (Binary) Image Variable 

This type of variable displays a different image on the controller's LCD  screen 
according to the status of a bit operand. 

 

Inserting and Defining the Variable

1.  Click on the variable in the Variable toolbar, then click on the HMI screen 
and drag your cursor to create a field for the display of the variable data.  

2.  Release the mouse button; a dialog box opens, enabling you to define the 
source of the variable data. 

3.  Link a bit operand, and select images for both bit states. 

Selecting Switch assigns an MB and built in Touch property to a binary Text or 
Image variable. Touching the variable toggles the image or text displayed. 

 



About the HMI Display and Keypad Display Variable Types

42 VisiLogic: HMI Applications

Numeric (Number) Variable 

A Number Variable enables you to: 

 Show any numeric value within a Display. 

 Control the format in which that value is shown, including the placement 
of a decimal point and leading zeros. 

 Use Linearization  to show a converted value, such as an analog 
temperature converted to degrees Celsius. 

 Allow the operator to use the controller keypad to enter a number, such 
as a setpoint, via a Keypad Entry Variable.  

Inserting and Defining the Variable 

1.  Click on the variable in the Variable toolbar, then click on the HMI screen 
and drag your cursor to create a field for the display of the variable data.  

2.  Release the mouse button; a dialog box opens, enabling you to define the 
source of the variable data. 

3.  Select from the features and formats shown below. 
Note that this image shows the options for a Standard Vision. 

 

To see how to use Keypad Entry Variables, refer to the Indirect Clock examp le. 

Touchscreen-only models (V290, V530)

These models have a 'virtual' keyboard. After a keypad entry variable is 
touched on the screen, the keyboard is automatically displayed, enabling the 
value to be entered. Note that you can set a font for variable display in Font 
Handler. 
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Notes • When an HMI keypad entry variable is active, and the Enter key is 
pressed on the controller keypad, SB 30 HMI Keypad Entries Completed 
turns ON. This can be used as a Jump condition. 

• SB 250, Keypad Entry within Limits, turns ON when a legal value is 
entered; SB 251, Keypad entry exceeds limits, turns ON when a value 
is out of range. You can use the status of these bits, for example, to 
provide a jump condition to another Display. When either of these SBs 
turns ON, the index number of the active variable is stored in SI 249. 

Note that you can limit the number of attempts by using SI 45 Numeric Key 
Entry Out of Limit - Counter of Attempts (Enhanced) to jump to another 
Display. 

SI 253 the user can change the password (or view it when the controller is On-
Line) 

Standard and Enhanced Vision Divisions 
Note that there are a number of differences between Vision Divisions. 

Keypad 
Entry 
Variables 

SB 92 Keypad Entry in 
Progress (ON during 
entry) (Enhanced 
Vision).. 
SB 93 Keypad Entry Var 
Activates (ON for 1 scan) 
(Enhanced Vision) 
SB 94 Keypad Entry Var 
Complete (ON for 1 scan) 
(Enhanced Vision) 
SB 250 HMI key entry 
within limits (Standard 
Vision only) 
SB 251 Keypad entry 
exceeds limits (Standard 
Vision only) 
SI 249 Last Active 
Keypad Entry Var 
(Standard Vision only) 

SB 92 Keypad Entry in 
Progress (ON during entry) 
(Enhanced Vision) 
SB 93 Keypad Entry Var 
Activates (ON for 1 scan) 
(Enhanced Vision) 
SB 94 Keypad Entry Var 
Complete (ON for 1 scan) 
(Enhanced Vision) 
SI 45 Numeric Key Entry Out 
of Limit - Counter of Attempts 
(Enhanced Vision) (Counts the 
number of failed attempts to 
enter a value) 
If a Legal Entry bit is defined, 
SB 94 does not turn ON if the 
entered value is out of range. 
The keypad stays on screen 
until a legal value is entered. 
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SI 250 Currently active 
keypad entry 
(read/write)  (Standard 
Vision only) 
SDW 10 Keypad entry 
variable value 

You can use SI 45 in 
conjunction with a Compare 
function to exit the variable. 

Active 
Keypad Entry 
(SBs) 

SB 32 HMI Keypad Entry 
in Progress (Standard 
Vision) rises during 
keypad entry 

SB 92 HMI Keypad Entry in 
Progress (Enhanced Vision) 
rises during keypad entry 

Keypad 
Entry: Focus 

After Keypad Entry, the 
next variable set in 
Variable Tab Order 
automatically becomes 
active. 

If SB 76 is OFF after Keypad 
Entry, the user must use the 
arrow keys to move to the 
next variable. 
Turning SB 76 on causes the 
next variable set in Variable 
Tab Order to automatically 
become active. 

Password 
Entry via HMI 

Correct password 
turns SB250 ON 
Wrong Password 
turns SB251 ON 

Legal Entry bit in Password 
Variable turns ON when 
correct password is entered. 

Entering a 
legal  keypad 
entry value 

SB 250 Keypad entry 
Within Limits turns ON 
for 1 scan 

SB 94 Keypad Entry Var 
Complete + Keypad entry 
property: Legal Entry MB 

Turns ON when entered 
value is within legal limits 
Turns OFF when entered 
value exceeds legal limits 

Entering an 
illegal  
keypad entry 
value 

SB 251 Keypad Entry 
Exceeds Limits turns ON 
for 1 scan 

Active 
Keypad Entry 
Variables 
(SIs) 

• SI 250 Last Active 
Keypad Variable 
contains the number of 
that variable 

• SI 251 Currently Active 
Keypad Entry contains 
the number of that 
variable. The 
application can change 
the operand value to 
force a variable into 
active state 

SI 250 Last Active Keypad 
Variable and SI 251 Currently 
Active Keypad Entry contains 
the number of the relevant 
DLU. 

Keypad Vars 
Locked 

Enhanced Vision (V130 
only) Turned ON by user 

Turn ON to lock all keypad 
entry variables. 

Enter Display 
with locked 
Keypad Entry 
Variables 

In Ladder application, set 
SB30 

Same

Enter ASCII 
value 

Currently Active Keypad Entry
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How Keypad Entry Variables Work 

Keypad Entry Variables enable a user to enter values via the Vision keypad. 

In order to enable the user to enter values, the variable must be active. 

When a variable is active, pressing Enter 'locks' the variable, and writes 
whatever value has been entered from the keypad into the variable. The next 
variable becomes active. 

Keypad Entry Variable 'Tab' Order

Variable Tab Order enables you to determine the order in which Keypad Entry 
Variables will be activated, regardless of their location on the LCD screen. 

Note • If Variable Tab order is not set, when the application is downloaded 
the variables will be activated in the order in which they were 
created. This may create the false impression that the variables are 
being activated 'randomly'. 

Clicking the Variable Tab Order button displays all of the keypad entry 
variables in a Display. 

 

When a Display contains more than 1 variable, using the right arrow key enables  
the user to tab from one active variable to the next. Pressing Enter 'lo cks' the 
variable, excluding it from the tab order. 

Displays containing Keypad Entry Variables

A Display with Keypad Entry Variables may be in one of two states: 

 Active  
The variables are active, marked by a blinking cursor. A Display loads into 
this state by default; the first variable, as set in Variable Tab Order,  will 
be active. 

System Status 
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# Description Value 

SB 30 HMI keypad entries completed OFF 

SB 32 HMI keypad entry in progress ON 

SI 250 Currently active keypad entry Number of currently active varia ble 

Locked  
When variables are locked, no cursor is present on the LCD. 

System Status 

# Description Value 

SB 30 HMI keypad entries completed   ON 

SB 32 HMI keypad entry in progress OFF 

SI 250 Currently active keypad entry -1 

You can load all Displays in a project in the locked state via SB 27, D isable all 
keypad automation. If SB 27 is ON when a Display is shown, the user cannot 
navigate through the variable using the keypad keys  and no cursor is present 
on-screen..  V280 users may, in order to enable variables to be activated only  
through 'touch', turn SB 27 ON as a power-up task. 

Note • When V290 is selected in Hardware Configuration, SB 27 is ON by 
default. When SB 27 is ON, no cursor is present on-screen. This 
enables the V290 user to activate any Keypad Entry Variable by 
touching it. 

You can also load a specific Display with all variables locked via SB 3 0, by 
building a net as shown below. Note that SB 30 should not be used to lock 
variables after  a Display has been loaded. 

 
After a Display loads, you can enable the user to skip  keying in data for all  of 
the variables on-screen, by turning SB 29 ON after data is keyed into an y 
variable. When a specific Display is on-screen, turning SB 29 ON, lock s all of 
the remaining variables. 

 
Notes • Regardless of the variable tab order, the user can activate variables 

by: 
 Touch, if the project is based on a touch-screen controller and 

if the touch property has been assigned to the variable. If this 
property is assigned, touching the variable activates it, causing 
it to be marked by the blinking cursor. 

 By writing the variable ID # into SI 250, either via Ladder 
program, Information or Online mode. 

These methods can also activate 'locked" variables, in which values 
have already been entered, or that have been locked via SBs 27, 
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29, or 30.

Relevant HMI SBs and SIs 

To see the variable ID numbers, open HMI Information from the View menu 
and click the Variables tab. 

 

Touchscreen models (V290V280)

There are 2 types of Vision touch-screen models: 

 Models which comprise only a virtual keypad (V290). In these models,  the 
virtual keypad opens whenever the user touches a keypad entry variable 
that is currently displayed on the screen. 
 

Models which comprise both an HMI function keypad and a virtual keypad 
(V280). However, in these models, the virtual keypad must be activ ated 
by turning SB 22 Enable Virtual Keypad ON (Note: SB22 is relevant only 
to Standard Vision + Touchscreen, not Enhanced) This must be done at 
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power-up, or before the Display containing the keypad variable is entered. 
In addition, the Keypad entry variable must be assigned a Touch Property. 

After a keypad entry variable is touched on the screen, the keyboard is 
automatically displayed, enabling the value to be entered. Note that you c an 
set a font for variable display in Font Handler. 

 
Note • When an HMI keypad entry variable is active, and the Enter key is 

pressed on the controller keypad, SB 30 HMI Keypad Entries Completed 
turns ON. This can be used as a Jump condition. 

• SB 250, Keypad Entry within Limits, turns ON when a legal value is 
entered; SB 251, Keypad entry exceeds limits, turns ON when a value 
is out of range. You can use the status of these bits, for example, to 
provide a jump condition to another Display. When either of these SBs 
turns ON, the index number of the active variable is stored in SI 249. 

System Bits, non touch-screen and touch-screen Vision PLCs

Certain SBs are only relevant to certain controller models, those with touc h 
screens and those without. Note that the V280 contains both touch-screen and 
keypad. 

Note that the V280 keyboard is 
enabled by default. The 

Which variable is active? Models with 
keypads 
In these controllers, a blinking cursor marks 
the active keypad entry variable. This 
cursor indicates that the user can begin to 
enter a value via keypad.   
The user navigates through the variables by 
using the directional arrows on the keypad. 
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information here is relevant 
when keypad entry variables 
are not  assigned touch 
properties. 

 

Controlling the cursor 
via SBs

SB 30 HMI keypad entries 
complete 

 Use SB 30 to run ladder 
tasks that require data 
entered via keypad. 

 Note that when a 
variable is active, 
pressing the Enter button 
on the keypad signals 
that the user has finished 
entering the value. 

 After  the Enter button 
has been pressed for all 
of the variables  in the 
current display, SB 30 
turns ON. 

SB 31 Refresh current LCD 
screen display variables 

 Use SB 31 to 
immediately re-enable 
data entry. 

 Turning SB 31 ON 
restores the cursor, and 
re-activates all keypad 
entry variables in the 
current display. 

SB 29 Current keypad entry sets SB 30
Turn SB 29 ON after data is keyed into any variable, to enable the user to 
skip keying in data for the remaining variables in the current display.   

 After SB 29 turns ON, SB 30 turns ON as well. 
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SB 76 Keypad Entry: Focus (V130 only)
If SB 76 is OFF after Keypad Entry, the user must use the arrow keys to move  
to the next variable. Turning SB 76 on causes the next variable set in Variable 
Tab Order to automatically become active. 

Touch -screen only ( V290)
The V290 does not have a physical keypad. When 
V290 is selected in Hardware Configuration, keypad 
entry variables must be assigned a Touch property. 
Then, when a keypad entry variable is touched, a 
virtual keypad is displayed on screen. 
Note that in a display that contains keypad entry 
variables, the variables are not marked by a blinking 
cursor. The programmer must include a clue to inform 
the user as to what part of the screen must be 
touched. 
In V290, SB 22 Enable Virtual Keypad, and SB 27 
Enter Display without active Keypad Entry Variables 
are ON by default. 
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Touch -screen and keypad (V280)
The V280 has both a physical keypad and a virtual 
keypad. 
Physical Keypad mode  
If you include keypad entry variables in your displays, 
by default, the V280 functions like other Vision models 
with physical keypads.  A cursor indicated keypad 
entry variables, and the user enters data via the 
physical keypad. 
Physical Keypad mode + Touch  
If you give Touch properties to keypad entry variables, 
a cursor still indicates active variables; however, you 
can page through these variable by touching them on 
the screen. The user enters data via the physical 
keypad. 
Physical Keypad mode + Touch + 'No Cursor"  
You can cancel the blinking cursor by turning SB 27 
ON. This also means that the user can only page 
through the keypad entry variables by touching them. 
Pressing the physical keypad arrows will not page 
through the variables. 
Virtual Keypad (V290) mode  
Turn SB 22 ON. When this is done, the V280 will 
function just like the V290 describe in the section 
above,. 

Clock Variables 

Place Clock Variables in Displays to show times and dates.  In addition to 
showing RTC values, use Clock Variables in conjunction with Indirect time 
functions to enable an operator to set times via the controller keypad. 

A keypad-enabled Clock Variable accepts a number entered via the controller 
keyboard, and stores the number in the operand linked to the Variable.   

 

Inserting and Defining a Keypad Entry Clock Variable
1.  Click on the variable in the Variable toolbar, then click on the HMI screen 

and drag your cursor to create a field for the display of the variable data.  

2.  Release the mouse button; a dialog box opens, enabling you to define the 
source of the variable data. 

3.  Check Keypad Entry and select the format and display font. 
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Note • Step -by -step instructions on how to use Keypad Entry Clock Variable 
values are provided in the Indirect Clock function example. 

Clock Variable: View\Enter  RTC\UTC  Values 

The Real-Time-Clock value in the controller can be shown in a Display. 

Inserting and Defining the Variable

Create a Variable field and select Real Time Clock , then define the 
Variable by selecting the time format and display font. You do not li nk an 
operand because this variable is already linked to the RTC. 

Note • Only full format variables, hh.mm.ss can be set as keypad entry.

UTC Variables 

Placing a UTC variable displays the value of the linked operands as an RTC 
value. 
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Note that if you select to display SI 30, the variable will display th e full RTC 
value. 

Keypad Entry 

On the screen, the variable is shown in Time format, according to your 
selection. 

 DW  
The 32-bit binary number contains the UTC value in seconds , where 
1900-01-01 = 00:00.00 UTC. 
 

SI  
To set the RTC from the HMI, link the UTC variable to SI 30; the value 
entered via keypad is written to RTC system operands SI 30-34. 
 

MI  
Linking an MI causes the UTC value entered via keypad to be written to a 
vector of 4 MIs, where the selected MI is the start of the vector. 

 

List of Texts: by Pointer 

This type of Variable contains numbered lines of text.  You link the Variab le to 
an operand.  The value within that operand 'points' to the number of a line 
within the list.  When the operand value is equal to a particular line number, 
the text of that line is shown in the Display. 

 

Inserting and Defining the Variable
1.  Create a Variable field, and then select List of Texts: by Pointer .

2.  Define the Variable by entering lines of text and linking an operand. 
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Note • By using the Keypad Entry Option, you can also enable the user to 
select a line using the Up/Down keypad arrows. 

• The Keypad Entry option is not supported for Touchscreen -only models 
(V290). 

List of Images: by Pointer 

This type of Variable contains a list of numbered images.  You link the Variable  
to an operand.  The value within that operand 'points' to the number of an 
image within the list.  When the operand value is equal to a particular image's 
number, that image is shown in the Display. 

 
Note • By using the Keypad Entry Option, you can also enable the user to 

select a line using the Up/Down keypad arrows. 
• The Keypad Entry option is not supported for Touchscreen -only models 

(V290). 
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Inserting and Defining the Variable
1.  Create a Variable field, and then select List of Images: by Pointer .

2.  Define the Variable by adding images to the List of Images and linking an 
operand. 

 

List of Images: by Range 

This type of Variable contains a list of images.  You define a range of values f or 
each image and link the Variable to an operand.  The value within this operand  
is compared to the range you have defined for each image.  When the operand 
value falls within a specified range, the image assigned to that range is shown 
in the Display. 

 
Note that you can define the beginning and end of a range using either a 
Constant value or an MI. 
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Inserting and Defining the Variable
1.  Create a Variable field, and then select Range of Images: by Pointer .

2.  For each line: define the beginning of the range, the end of the range, and 
assign an image. 

 

Graphs: Displaying Values 

Bar and Shape graphs can be used to show how values progress.  You can use 
them together with other Display elements to help operators track system 
progress and status. 

This is a sample of an HMI Display and how its elements can look on the  
controller's LCD. 
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Note • Vision controllers also support Trend graphs

Inserting the Graph

1.  On the HMI toolbar, click on a Graph  icon; then drag the cursor across 
the controller screen to create the graph object. 

2.  Select the appropriate options. Graph options vary according to the Vision 
Division and HMI Display type. 

Defining the Graph

Standard Vision: V120/230/260/280/290 Monochrome

Bar graph 
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Shape graph  

Enhanced Vision

Bar graph  
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Parameter Type Function 

Direction Selection option Select the direction in which the bar will grow 

Min/Max Constant or 
register 

Sets Limits 

Fill Color Selection option Click to open Color pallet and select a color for th e bar 

Meter graph  

Click the tabs to configure the appearance of the Meter. 

 

Tab Function 
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Arc Click and drag the slides to adjust the Radius, Arc Angle, and Ro tation 

Needle Adjust the appearance of the needle 

Ticks Adjust Tick length and thickness 

Label And 
Background 

Edit the Meter name, and select a background color or image 

Ranges Assign colors to different sections of the Meter's Arc 

Tank graph  

Parameter Type Function 

Tanks Selection option Select the tank type 

Min/Max Constant or 
register 

Sets Limits 

Fill Color Selection option Click to open Color pallet and select a color for th e tank 

If the background color is displaying incorrectly, note that a tank object should 
not be placed on a white background. In this case, certain tank objects might 
be partially framed in yellow frame. Any other color may be used. In additio n, 
note that changing the background color of the display does not change the 
background color of the .emf tank graphic. 

V290 color, V570

Trends 

LEDs 

The bars in a LED graph represent a changing value in the same way that the 
lights of a stereo equalizer represent the sounds. You configure the number 
and color of the LEDs in the graph. 
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Parameter Value 

Number of 
LEDs 

Maximum number = 32. 

Min/Max Depends whether the link is to a single or double register; for ex ample MI range is 
32768 to +3276; ML range is -2,147,483,648 to +2,147,483,647. 

LEDs Preview Use the slider to check the appearance of the graph. 

Fore Color Click to edit the color surrounding the LEDs. 

Direction Changes the orientation of the graph 

From Assigns the number of LEDs to the value range. 
For example, the following image shows that the low range assigned to  Green is 0-
30; there are 3 bars assigned to that range. 
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Note • The minimum width of a LED bar is 2 pixels, and that the space 
between bars is 2 pixels. If the height of the graph is not evenly 
divided by the number of pixels used by the bars and spaces, the 
remaining pixels will be colored as the Fore Color. 

 

Thermometer  

Represents a value by changing the level of a thermometer icon. 

 

Parameter Value 

Min/Max Depends whether the link is to a single or double register; for ex ample MI 
range is 32768 to +3276; ML range is -2,147,483,648 to +2,147,483,647. 

Ticks Change number and color. 
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Trends 

A Trend graph displays a dynamically changing value graph that tracks a 
single, dynamic value such as a temperature value, as a curve on the Vision 
screen. 

Note • Trends (Legacy) Function Block
If your project is configured to Standard Vision controllers that do 
not support HMI object Trend graphs, the Trend objects will not be 
displayed in the Project Navigation Window. In these models, use 
the Trends (Legacy) Function Block.   

Trends are displayed in the Project Navigation Window.  The number of Trends 
and Curves that can be displayed depends on controller model: 

 V570/V350  
Up to 8 Trends, each displaying up to 8 Curves 

 V130  
Up to 4 Trends, each displaying up to 2 Curves 

Each Curve may be linked to a different register, and can be configured to a 
different color. 

Trends have a default touch property that causes a touched Curve to be 
brought forward. In the following figure, the Temperature curve is in front.  

Touch the Mode button to toggle between: 

 Run Mode: 
Shows the Trend being drawn in real-time 

 History Mode: 
Stops the Trend, displays History Scroll buttons; touch these to scroll back 
and forth between different Trend graph sections 
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V130  

Since the V130 does not offer a touch screen, you use the Keypad arrow 
buttons to enter and navigate through History Mode 

Enter History Mode Up arrow
Exit to Online Mode Down arrow
Scroll through History Left and right arrows

Creating a Trend graph

1.  Define a Trend:  
Right-click the desired Trend to open and set Trend Properties. 
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Property Function 

Name Assign a unique name to the Trend. 

Sampling Interval Defines how often the Trend draws Curves, resolution  
= deciseconds (0.1.) 

History Samples Total number of samples that may be stored in History 
for ALL Trends is 32000.  The minimum number that 
may be allocated to a Trend is 50. 
To view the total History Allocation,  
right-click Trends in the Project Navigation Window 

Run / Stop MB 0= Stop 
1=Run 
Status rises from 0 to 1: 
• The PLC begins to draw the Trend Curves 
• The History is initialized 
• 'Run' is displayed at the bottom of the graph 
Falls 1 to 0 
• Trend freezes 
• Under can press Mode button to enter History and scroll through 

Trend 
• 'Stop' is displayed at the bottom of the graph 

2.  Define Curves  
Right-click the desired Curve to open and set Curve Properties. 

 

Property Function 

Name Assign a unique name to the Curve for display on the 
HMI screen. 
You can also use the String Library. The string you 
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select will be displayed as the Curve name on the HMI 
screen; however, note that the string you select will 
not appear on the Project Navigation tree. 

Data Operand This is the value represented by the Curve 

Y Min, Y Max These define the axis range for that Curve. Note that 
you can also set a decimal value. 

Once you configure a Trend and at least a single Curve, you can place the 
graph in different HMI displays and set specific properties for the Trend in t hat 
display, such as the Trend background color and Curve colors. 

3.  Place a Trend Graph in an HMI Display 

a.  Click the Trend icon on the HMI toolbar, and then drag the cursor across 
the screen to draw the Trend. 

 
b.  Release the mouse button, and define the Trend Variable properties.   

 
Note • Under Links, note that the Link MI shows which Curve is currently 

forward 
 V570 1= Curve 1, 2=Curve 2, etc. Therefore when the MI 

contains 3, Curve number 3 will be forward 
 V130:2=Curve 2. 1, or any other value causes Curve 1 to be 

forward 
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Tab Property Function 

Appearance Points to Display Sets the number of actual points that will be shown on the 
screen at any one time 

Number of X ticks, Y 
ticks 

Set the number of gradations on the axes 

History scroll mode Sets the paging size for History view 

Draw lines between 
points 

If this is not selected, the Curves will be drawn as a series of 
points 

X Axis Color Note that the Y Axis color always changes to match the Curve 
than is in front 

Buttons Color Sets the color for the Mode, Grid, and History Scroll buttons 

Grid Color Set the color for the background Grid 

Change current 
Curve on Touch 

Checked by default. Curves have a built-in touch property 
that causes the touched Curve to be brought forward. 

Curves Color Click to set a color 

Hide Curve if you assign a Hide Curve MB, turn it ON to hide the Curve . 

Note that the Link MI determines which curve is forward. In the case of the 
V570, touching the curve writes the curve value to the MI, bringing the 
touched curve forward. 
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Trend from SD

Note that you can also display a Trend Curve from the Trend History that is 
stored on an SD Card. The parameters are the same as in Variable: Trend, 
given above. 

 

4.  Control the Trend by toggling on the Run/ Stop MB assigned in the 

Start and stop the Trend as shown below. 

 
To learn more about Trends, check Trends - Color Vision.vlp in the Help> 
Examples. 

# Description Value Comments 

SI 63 Maximum number of 
Trend files that can be 
saved (read-only) 

0-64 
The maximum amount of 
Trend files (*.utr files) in a 
single folder is 64. The 
value in SI 63 shows the 
number of remaining *.utr 
files; if 5 *utr files exist, SI 
63 = 59 

• Initialized at Power-up. 
• Updated when: 

- when SB 217 is ON 
- when Trend file is created. 

 

SD Card Browser 

Placing this variable on screen enables a user to press a button to display all of 
the files in the specified folder. 

 Touch Screens (V570/V350): The user presses the Browse SD on-screen 
button. If file selection is enabled, the user touches files names to sel ect 
them. 

 Non-Touch Screens (V130): The user presses the Enter button, and 
navigates between files using the arrow keys. 

SD Ladder Functions enable you to read/write data between an SD Card and 
PLC memory operands, including blocks of file data, Data Tables, and Tre nd 
data. 

You can also enable the user to delete files, or to copy the file name to an 
operand vector. You can control whether to display the Delete button by using 
the Hide Delete File MB. 

Note • The SD Card Browser only displays file types that are relevant for the 
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requested folder. For example, when you view DT files, you will only 
be able to see .udt and .fdt files; if there are other files in the folder 
they will not be displayed. 
In the Web folder, all file types are displayed 
Note that in VisiLogic versions earlier than 8.0.46, EXCEL folders  
cannot display .txt 
files. In addition, PLCs running an OS earlier than 3.0.59 do not 
support .txt display. 

Moving Image 

This type of variable displays a moving image on the controller's LC D screen; 
the image moves according to the value of the linked MI. This feature is on ly 
supported by the Standard Vision Division 
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value falls within a specified range, the text assigned to that range is shown in 
the Display. 

 
Note that you can define the beginning and end of a range using either a 
Constant value, or an MI. 

Inserting and Defining the Variable
1.  Create a Variable field, and then select Range of Texts: by Pointer .

2.  For each line: define the beginning of the range, the end of the range, and 
assign text. 

 

3.  Use the Add Line button and Delete Line button as 
needed. 

 

String Library 

Use String Library to store text strings within the controller's FLASH me mory, 
and then display them on the controller's LCD. You can, for example, organize 
text into different String Libraries—for example, separate libraries for Spanish, 
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English and Italian—pull strings into HMI objects, and then switch librarie s to 
change the display language. 

These strings can be displayed in the following HMI elements: 

 Frame 

 Button 

 Fixed Text 

String Libraries also provide the text for Alarms, and can be used in Trend 
Curve Properties. 

There are: 

 16 String Libraries containing up to 1024 strings each. You can change the 
library default names. 
Via String Library> File, you can opt to use only 4 or 8 libraries; in this 
case the total number per library is 2,046 strings. 
Note that each library contains sections in the 3,000 range, that are 
‘greyed'; these are reserved for system use. 

 Each string can contain up to 128 characters. 

The total memory capacity  for all String Libraries is 64K. 

 This feature is not available in Standard Vision controllers.

How String Library works

Only one library is active at a time. This means that at any given time, al l 
elements that pull text from a library are using the same  library. 

However, each  HMI element may be linked to a different  line ID # within that 
String Library. 

In the following figure, the buttons are linked to different text lines. E ach time 
a different String Library is called, the button text changes. 

 

Configuring Strings

1.  Click the String icon on the navigation tree or toolbar to open the Strings 
editor. 
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2.  Click on File> Rename Library to assign a unique name to the Library 
 

3.  Double-click on a row to open the String Editor. 
Note that the String Editor opens strings according to the ID #. In the 
following figure, the first three messages are displayed for String Librari es 
Letters_1, Numbers_2, and Symbols_3. 
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3.  Place your cursor in the desired String Library row, and type in text. You 
can also include indirect text from an MI vector. 
The text is displayed in the PLC Preview window. 

 
You can also break text lines by including Carriage Return + Line Feed 
characters. 
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Note that you can find Unreferenced Strings via the binoculars icon on the 
String Library toolbar. 

Importing/Exporting Strings to/from Excel or .csv

These tools are located on the String Library File menu. 

 Excel: you cannot create an Excel file and import it. You must export a 
String Library from a String Library, delete any undesired information, 
and then enter your own strings. 
.csv: you must use a delimiter that does not appear within the string's 
data, or the values will not be separated according to expectations. 

Import/Export from Excel
1.  Select all of the Strings in a Library. and then select Export 
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2.  From the File menu, select Export to Excel. 
 

3.  Open and edit the Library, and then import it into any Library. 

Linking HMI Elements to Text in a String Library

1.  Place a Frame, Button, or Fixed Text HMI element. Within the element 
properties, click the String from String Library option. 
You can either link a Text ID line directly, or use an MI to indirectly 
provide the Text line ID. 

Note that the size of the HMI element must be large enough for the longest 
text line it may hold. 
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Switching Libraries

To switch Libraries, use one of these methods: 

 Use the Ladder function Strings>Set String Library 

 Write a value to SI 491 Switch current Text Library 

ASCII String 

You can display a vector of MI, ML, or DW values as an ASCII string. The  value 
of each byte in the vector is displayed as an ASCII character. You can also 
enable a user to enter characters directly into the variable by pressing keys on  
the Vision keypad. ASCII String is located on the Text Variable m enu. 
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The Display String 'trigger' MB is set and reset by the user. Note that the OS 
refreshes the string and resets the MB when the MB turns ON. If the MB is 
continuously set by the application, the change in status will not occur and the 
string will not be refreshed. 

Note • String Pattern defines the size of the text field. The default string 'Text 
To Display' will provide a field long enough to contain most strings. 

• SBs 33 and 34 function when an HMI Display that calls a subroutine
is loaded/unloaded from the display screen. 
In cases where a Display contains a Variable:ASCII String, and the 
linked subroutine contains the Display String 'trigger' MB, you can reset 
this MB when the Display unloads by using the falling edge of SB 34. 

To create a field that contains enough bytes to provide for the width of the 
ASCII characters in a variable string, enter a line of text in String Pattern that 
contains characters of the necessary width. 
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The character ' W ' is generally the widest character in a font set. 

 
Note • A vector is read either until the end of the defined vector length, or 

until a 'null' character is encountered. By adding a null  character  to 
the end of the stream, you can mark the end of a data string. This can 
prevent other data, that might be present in a vector, from being 
added to the data string when the vector is read. 

Entering ASCII via keypad

When you select Keypad Entry, the user can enter upper and lower case 
characters as well as symbols. 

Vision: Standard Keypad
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Vision: Color Touchscreen models

When the user touches the screen, the virtual keypad opens. Use the top 
arrows to page between keypads to enter capital letters, lower-case, and 
symbols. 

 

Vision: Monochrome Touchscreen models
There are 2 types: 

 Models which comprise both an HMI function keypad and a virtual keypad 
(V280). 
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Models which comprise only a virtual keypad (V290). 
Note • In models which comprise only a virtual keypad (V290), the virtual 

keypad opens whenever the user touches a keypad entry variable that 
is currently displayed on the screen. 
However, in models which comprise both an HMI function keypad and a 
virtual keypad (V280), the virtual keypad must be activated by turning 
SB 22 Enable Virtual Keypad ON. This must be done at power-up, or 
before the Display containing the keypad variable is entered. 
In addition, the Keypad entry variable must be assigned a Touch 
Property. 

Strings: Display RTC (ASCII) 

You can display an RTC value as an ASCII string by using the RTC to ASCII 
function together with the ASCII String variable. 

To use Display RTC: 

1.  Select RTC to ASCII from the String menu on the Ladder toolbar. 

2.  Place the function in the net, and select a display format; both European 
and American format are available. 

3.  In the HMI Display, select Display RTC from the Text Variable menu. 

When the program shown below is downloaded, pressing key 1 on the Vision's 
keypad will display the current time on the Vision's LCD. 
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.

Password: Keypad Entry 

You can insert a Password Variable that requires operators to enter a password 
via the controller's keyboard. 

Note that Passwords are handled differently in Standard and Enhanced Vision 
Divisions, as described below. 

Standard Vision  
Note • SB 250, Keypad Entry within Limits, turns ON when a password is 

correctly entered; SB 251, Keypad entry exceeds limits, turns ON when 
a password is incorrect. You can use the status of these bits, for 
example, to provide a jump condition to another Display. When either 
of these SBs turns ON, the index number of the active variable is store d 
in SI 249. 

1.  Select Password  from the Numeric menu, and drag your cursor across 
the screen to create the Password field. 

2.  Click Link to assign either a Constant value or DW. Note that selecting DW 
also enables you to set the number of asterisks shown in the Password 
field. 
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Note • Standard Vision division: When an HMI keypad entry variable is active, 
and the Enter key is pressed on the controller keypad, SB 30 Variables 
Locked turns ON. This can be used as a Jump condition. 

Enhanced Vision  

The Password field is a touch-screen button. When the user touches it, the 
virtual keypad appears, enabling the user to enter the password. 

1.  Select Password  from the Numeric menu, and drag your cursor across 
the screen to create the Password button. 

2.  Assign Display text to be shown within the button. If you leave this blank, 
asterisks will be shown in the button by default. 

3.  Click Link to assign either a Constant value or DW. 

4.  Assign an MB to Legal Entry; this MB will turn ON when the correct 
password is entered. You can use this to jump to another Display. 
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Note that you can limit the number of attempts by using SI 45 Numeric Key 
Entry Out of Limit - Counter of Attempts (Enhanced) to jump to another 
Display. 

 

SI253 the user can change the password (or view it when the controller is On-
Line) 

 

Timers: Displaying Values 

A Timer Variable shows a timer's value in a Display. 

1.  Create a Variable field, and then select Timer.  

2.  Select from the features and formats shown below. 
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Display/Preset Counter Values 

A Counter Variable shows a counter's value in a Display.  

1.  Create a Variable field, and then select Counter.  

2.  Select from the features and formats shown below. 

 

'Touch' Property (Touchscreen models only) 

When a touchscreen controller, such as the V280, is selected in Hardware  
Configuration, you can assign Touch properties to any screen element. With 
the exception of keypad entry variables, Touch elements are linked to M Bs. 
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1.  Select any screen element, then click the Assign Touch Property button; 
the Select Operand box opens, enabling you to link an MB. 

When this element is touched, the linked MB will turn ON, when the element is  
not touched, the MB will be OFF. 

 

To edit the MB that is already linked to the Touch element, select the eleme nt 
and then click the Assign 'Touch" Property icon; the Select Operand box opens . 

Note • An MB that is linked to a 'Touch' element cannot be linked to any other 
element on the Display. The MB may be linked to 'Touch' elements in 
different  Displays. 

Text 
Fonts 

Fonts are used in text boxes and to display Variable data. 

Note • Fonts are not standardized. For example, two different PCs may both 
contain a font called Arial. Displays created on one PC using that font 
may look different or distorted when opened on the other PC.  This can 
be fixed by opening the application and replacing the font; you may 
replace the font with a font of the same name to solve this problem. 

Font Handler 

Font Handler enables you to define the fonts and character sets you use to 
write text in Displays. 
Use Font Handler to: 

 Add fonts.  Note that VisiLogic is supplied with a single default font. 
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Define fonts, including size, style, and effect. 

 Delete unused fonts, and unused characters. This can dramatically 
decrease the font memory requirements. 

 Select foreign or special characters, such as degree signs. 

Using Font Handler

Open Font Handler by clicking the  icon on the toolbar, clicking it in Tex t 
Properties, or by selecting it from the HMI menu. 

 
International characters are supported via the Script box, which displays al l 
Windows fonts installed on your PC. 

Note • Color Vision models, such as V570, use default system fonts. These 
fonts (which are highlighted in grey) contain a limited character set, 
and cannot be modified. 
To add a font that contains additional / multilingual characters, click on 
the Add New Font button.. 
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Note  • Any characters within a font that are too big to be displayed on the 
controller's LCD will be marked in red. 

 

If you are using an Enhanced Vision with a touch screen, you can select the 
keyboard that Vision displays for Keyboard Entry variables. 
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Text: Fixed 

Fixed (constant) text does not change according to run-time conditio ns.   

To place fixed text messages in a Display :

String Library 

Use String Library to store text strings within the controller's FLASH me mory, 
and then display them on the controller's LCD. You can, for example, organize 
text into different String Libraries—for example, separate libraries for Spanish, 
English and Italian—pull strings into HMI objects, and then switch librarie s to 
change the display language. 

These strings can be displayed in the following HMI elements: 

 Frame 

 Button 
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Fixed Text 

String Libraries also provide the text for Alarms, and can be used in Trend 
Curve Properties. 

There are: 

 16 String Libraries containing up to 1024 strings each. You can change the 
library default names. 
Via String Library> File, you can opt to use only 4 or 8 libraries; in this 
case the total number per library is 2,046 strings. 
Note that each library contains sections in the 3,000 range, that are 
‘greyed'; these are reserved for system use. 

 Each string can contain up to 128 characters. 

The total memory capacity  for all String Libraries is 64K. 

 This feature is not available in Standard Vision controllers.

How String Library works

Only one library is active at a time. This means that at any given time, al l 
elements that pull text from a library are using the same  library. 

However, each  HMI element may be linked to a different  line ID # within that 
String Library. 

In the following figure, the buttons are linked to different text lines. E ach time 
a different String Library is called, the button text changes. 

 

Configuring Strings

1.  Click the String icon on the navigation tree or toolbar to open the Strings 
editor. 
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2.  Click on File> Rename Library to assign a unique name to the Library 
 

3.  Double-click on a row to open the String Editor. 
Note that the String Editor opens strings according to the ID #. In the 
following figure, the first three messages are displayed for String Librari es 
Letters_1, Numbers_2, and Symbols_3. 



About the HMI Display and Keypad Text

92 VisiLogic: HMI Applications

3.  Place your cursor in the desired String Library row, and type in text. You 
can also include indirect text from an MI vector. 
The text is displayed in the PLC Preview window. 

 
You can also break text lines by including Carriage Return + Line Feed 
characters. 
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Note that you can find Unreferenced Strings via the binoculars icon on the 
String Library toolbar. 

Importing/Exporting Strings to/from Excel or .csv

These tools are located on the String Library File menu. 

 Excel: you cannot create an Excel file and import it. You must export a 
String Library from a String Library, delete any undesired information, 
and then enter your own strings. 
.csv: you must use a delimiter that does not appear within the string's 
data, or the values will not be separated according to expectations. 

Import/Export from Excel
1.  Select all of the Strings in a Library. and then select Export 
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2.  From the File menu, select Export to Excel. 
 

3.  Open and edit the Library, and then import it into any Library. 

Linking HMI Elements to Text in a String Library

1.  Place a Frame, Button, or Fixed Text HMI element. Within the element 
properties, click the String from String Library option. 
You can either link a Text ID line directly, or use an MI to indirectly 
provide the Text line ID. 

Note that the size of the HMI element must be large enough for the longest 
text line it may hold. 
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Switching Libraries

To switch Libraries, use one of these methods: 

 Use the Ladder function Strings>Set String Library 

 Write a value to SI 491 Switch current Text Library 
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